
What is the Search Facility?

Unlike the ProViewers Find and Find Again commands, which look in the current 
document only, the Common Ground Search facility allows you to look through 
collections of documents to locate those documents that contain specific text phrases.

A collection is a defined group of Common Ground documents. You define a document 
collection by specifying a description for the collection, its location, and choosing one 
or more Common Ground documents to be the members of the collection. You can 
create as many document collections as you wish, and you can search in one or more 
collections to locate documents that satisfy your query. 

ProViewers Search menu contains the different Search commands, many of which are 
also present as icons on the ProViewers Toolbar. In addition, a Common Ground Search 
icon on the Common Ground Program Group gives you direct access to Search without 
having to launch the ProViewer. The Search Results List displays any matching 
documents as a result of the search. You can use this list to select and view the 
documents in the ProViewer.

See also
Adding an Existing Collection
Creating a Collection
Editing a Collection. 
Removing a Collection 
Selecting a Collection 



Creating a Collection

The first time you invoke the Search command you must create at least one collection 
and add documents to it before you can perform a search. 

To create a document collection:

1. Open the Search window using one of the following methods:

· From the ProViewer, click on the Search button in the Toolbar or choose the 
Query command from the Search menu.

· From the File Manager, click on the Common Ground Search icon in the 
Common Ground program group.

2. Click on the Collections button in the Search window to display the Document 
Collections dialog box.

3. Click on the Create button to open the Create Collection dialog box.
4. Complete the following information

· Type a description into the window. This description can be any combination 
of characters. 

· To use a location other than the displayed default location, click on the 
Location button. The Select Location dialog box opens:
Select the drive and directory where your document collection will be 
created. and click on the OK button when you have specified the location.

5. Click on the OK button in the Create Collection dialog box . 
6. When the Edit Collection dialog box appears, select the documents you wish to 

include in this collection:

· Highlight the name of a document and click on the Add button.
· Click on the Add All button to place all of the documents in the collection. 
· To remove a document from the collection, highlight its name in the bottom 

window and click on the Remove button. 
· To remove all documents from the collection, click on the Remove All 

button.
7. Click on the Close button to create the collection. The Document Collections 

dialog box reappears with the new collection listed there. 

See also
Adding an Existing Collection
Creating a Collection 
Editing a Collection. 
Removing a Collection 





Selecting a Collection

You can choose which collections you want included in the search process. You check 
(or uncheck) collections in the Document Collections dialog box to identify    which 
collections to include in the search. Collections that have a check mark in the check 
column will be included in the search; collections without a check mark are not 
included in the search.

To select a collection:

1. Open the Search window and click on the Collections button to display the 
Document Collections dialog box. 

2. Double-click in the check column next to the document you want to select. You 
can also click on the collection description and press the space bar once to 
select a collection

To deselect a collection:

1. Open the Search window and click on the Collections button to display the 
Document Collections dialog box. 

2. Double-click on the check mark    next to the document you want to remove 
from the search. You can also click on the collection description and press the 
space bar once to deselect a collection

See also
Adding an Existing Collection 
Creating a Collection
Editing a Collection. 
Removing a Collection 



Adding an Existing Collection

You can add existing collections created elsewhere to your list of collections. This 
facility allows you to share collections with other users as long as you can access them.

To add an existing collection:

1. Open the Search window and click on the Collections button
2. Click on the Add button to display the Add Collection dialog box.
3. Locate the collection that you want to add by changing the drive and directory 

in the dialog boxes. Click on the description to highlight it.
4. Click on the Add button to add the collection to your list.

5. Repeat this process to locate and add other collections.

6. When you are finished locating and adding collections, click on the OK button. The 
Document Collections list now displays the collections you just added.

See also
Creating a Collection
Selecting a Collection
Removing a Collection 



Editing a Collection

You can add or delete documents in a collection using the Edit Collection dialog box. 

To edit a collection:

1. Open the Search window and click on the Collections button
2. Highlight a collection description and click on the Edit button to display the Edit

Collection dialog box. 
3. To add a document to the collection:

a. Locate the collection that you want to add by changing the drive and 
directory in the dialog boxes. 

b. Click on the description to highlight it.
c. Click on the Add button

4. To delete a document from the collection:

a. Highlight    the document's name in the Files in Collection box
b. Click on the Remove button

5. When you have finished adding and removing documents, click on Close.
        Double-click on a collection description to open the Edit Collection dialog box.

See also
Adding an Existing Collection 
Creating a Collection
Selecting a Collection 
Updating a Collection



Updating a Collection

In addition to editing a collection by adding and removing files, you also edit a 
collection to update the index for one or more files that changed since they were 
originally added to the collection.    You do not have to update the collection manually: 
Search keeps track of the time stamps on files in a collection. If the file is later 
retrieved during a search and its time stamp is more recent than the time stamp on the
collection itself, you will be given the option to update at that time.

To update a collection:

1. Open the Search window and click on the Collections button
2. Highlight a collection description and click on the Edit button to display the 

Edit Collection   dialog box  . 
3. Highlight a document and click on the Update button to re-index that file.

You can click on the Update All button to re-index all files in the collection.
4. When you have finished updating a document, click on Close.
        Double-click on a collection description to open the Edit Collection   dialog box  .

See also
Adding an Existing Document
Creating a Collection
Editing a Collection
Selecting a Collection 



Removing a Collection

You can delete a collection from your list of collections. You can simply delete the 
collection from your list or you can delete the collection and its definition from your 
system. Deleting a collection does not affect any of the individual document files 
contained in the collection.

To remove a collection:

1. Open the Search window and click on the Collections button
2. Highlight a collection description 
3. Click on the Remove button to display the Remove Collection dialog box.
4. To delete the collection from your list, click on the Remove button.
5. To delete the collection from your list and delete its definition from your system:

· Check "Delete the collection from disk" 
· Click on the Remove button

6. Click on the Close button in the Document Collections dialog box to close the 
dialog box.

See also
Adding an Existing Document
Creating a Collection
Updating a Collection



Starting a Search

You can search through documents in one or more collections using the Search window.

To start a search:

1. Open the Common Ground Search window using one of the following methods:

· Click on the Query icon in the Toolbar
· Choose the Query command form the Search menu
· In the Program Manager, double-click on the Search icon in the Common 

Ground Program Group
Note: The first time you do this, Search prompts you to create at least one collection 

and add documents to it before you can perform a search.

2. Choose "All collections" (the default) or "Selected collections" from the Search 
in menu.

· If you choose "All collections," be aware that the search could take a long 
time, return too many documents, or return documents that you do not 
need.

· If you choose "Selected collections," Search will only look in check-marked 
collections in the Document Collection list.

3. Type your search string into the Search for field. (See "Specifying a Query" for 
more information.)

4. Click on the Search button. Search locates all documents that satisfy the query 
and its constraints.

See also
Improving Your Search Results 
Search Facility Description 
Specifying a Query 



Specifying a Query

You enter your query in the Search for field of the Search window. The simplest form 
of search requires only that you have one collection defined and type a search string, 
or search term, into the Search for field. You can perform a more complex search, 
using options or constraints not available to you in the query language, by expanding 
the Search Window.

        See the Query language document in the Common Ground program group.
The following examples show how to specify different search terms. 

Simple Search Term

A simple search term is either a single word, a single word preceded by not, or a 
phrase. 

A Look for documents that contain A.
A B Look for documents that contain A immediately followed by B
not C Look for documents that do not contain C, or, equivalently, 

exclude documents that contain C.
Compound Search Term

A compound search term is two or more simple search terms connected by 
operators and and or. 

A and B Look for documents in which both A and B appear.
and Operator

The and operator takes precedence over the or operator. For example:

A and B or C Look for documents that contain A and B, or documents that 
contain C.

not Operator

The not operator is always applied first.

A and not B Look for documents that contain A and in which B does not 
appear.

Building Search Terms

· You can use parentheses to clarify combinations of search terms.
A and (B or C) Look for documents that contain A and documents that 

contain either B or C.
· You can search for a phrase containing a reserved word by enclosing that word 

in quote marks. 
A "and" B C Look for documents that contain A followed by "and" followed 



by B C, as in: "black and white TV."
· You can enter a list of search terms separated by commas. The search retrieves 

documents that include at least one of the search terms you specify. 

See also
Search Facility Description 
Starting a Search



Search Window (Standard)

To display the Search window:
Use one of the following methods

· Click on the Query icon in the Toolbar
· Choose the Query command form the Search menu
· In the Program Manager, double-click on the Search icon in the Common 

Ground Program Group
Note: The first time you do this, Search prompts you to create at least one collection 

and add documents to it before you can perform a search.

Search Window Options

Search in

Specify whether Search should look through all of your collections

Selected collections Limit search to the collections checked in the 
Document Collection dialog box

All collections Search all documents in all collections

Collections button

Display the Document Collections dialog box.

Search for

Specify the query, or search terms, as an alpha-numeric string.

Search button

Start the search process.

More button

Expand the Search window to display additional options to constrain your query:

See also
Expanded Search Window
Search Facility Description 
Starting a Search 



Expanded Search Window

The expanded search window is a longer version of the standard Search window. When 
you click on the More button in the Search window, the window lengthens to display 
additional search options.

Use the expanded Search window to limit the search to a specific publisher, date 
ranges, and a specific number of documents. You can set other options (described 
below) to further refine your search.

To access the expanded Search window:
Click on the More button in the Search window.

Expanded Search Window Options

Standard Search Window Options

See Search Window (Standard) for a description of these fields.

Publisher and Organization

The default is to search in documents that you authored; Search automatically 
completes these fields with your author and publisher information.

 You can change either the Publisher or the Organization by entering new text, 
or you can leave these fields blank to search in all documents.

Keywords

Specify one or more keywords to limit the Search to only those documents that 
have matching keywords.

Creation Date: After and Before

Specify a date in either or both of the fields to limit the search to only those 
documents with creation dates that fall within this date range. 

Dates entered in this field must use the Short-Date format you selected in the 
International settings in the Windows Control Panel. Refer to your Windows 
Users Guide for more information.

Modification Date: After and Before

Specify a date in either or both of the fields to limit the search to only those 
documents whose last modification date falls within this range of dates.

Maximum number of documents

Limit the number of documents displayed in the Search Results window to the 



integer that you specify.

Minimum acceptable score

Limit the search to documents with scores equal to or higher than the number 
you specify.

Word Match

Specify the how you want the query interpreted. 

Exact Interpret the query literally: the words in the document must 
exactly match the words in the query. 

Stem (Default) Retrieve documents that include one or more variants of the 
search term. For example, if the search term is "assert," 
Search retrieves documents that contain assertion, asserts, 
asserting, asserted, and so on.

Thesaurus Use the Search Thesaurus to retrieve documents that contain 
one or more synonyms of the specified search terms.

Match Case

Use upper and lowercase characters in the query literally. All characters must 
appear in a document exactly as you specified them in the Search for field.

Use Proximity

Make the score that the document receives a function of the proximity of the 
search terms to each other. The closer the terms, the higher the documents 
score. If the search terms are more than eight words apart, Search does not 
consider them to be in proximity to each other.

This option works only if you check this box and specify several search terms in 
your query using commas.

Refine

On the next search, use the previous Search Results List as the new "search in" 
list and apply the constraints you entered in the expanded Search window. 

This check box is disabled until you have run at least one search and obtained a
results list. 

Less Button

Display only the standard Search window fields. This button returns the Search 
window to its default size.

See also
Search Facility Description 



Search Window
Starting a Search 



Search Results Window

Search displays results of a search process in the Search Results window. This window 
lists the documents that contain the search terms. Next to each document name is an 
icon. If the icon contains a plus (+), the document contains a Table of Contents to help 
you locate the search hits in that document. Initially, the highest scoring document is 
displayed at the top of the list.

Window Fields

Score

Each document is given a score. The highest score is 100, indicating that the 
document is considered a "perfect match" for the search criteria; the lowest 
possible score is 0, indicating that no match was found in the document.    
Documents with scores of 0 are irrelevant for your search and do not appear in 
the Search Results List..

Table of Contents Icon 

The document icon  identifies a document that has a Table of Contents. 
Double-click on the icon to display the Table of Contents. The icon symbol 
changes from a plus (+) to a minus (-). You can click on an entry to highlight it, 
and then click on the Open button to View that document starting at the point 
you selected in its Table of Contents.

The document icon  indicates that the Table of Contents is currently displayed. Double-click
on the icon to remove the Table of Contents display.

Show Context 

Check to display the context of each hit. A list of matches appears below the 
document name. Highlight a match, then click on the Open button to open the 
document in the ProViewer and display the selected hit in the Document 
Window.

Open and View a Document

View    the selected document. Select the document by highlighting its name, 
one of its hits, or one of its Table of Contents entries and click on the Open 
button. The ProViewer displays the selected document with the first (or 
selected) hit or Table of Contents entry visible in the Document Window.

          Double-click to open a document in a single step.
New Search

Redisplay the Search window, allowing you to change any of the search 
parameters and run another search. 

See also



Navigating the Results of a Search 
Search Facility Description 
Starting a Search 



Navigating the Results of a Search

When the ProViewer displays the document that you selected from your Search Results 
List, the first or selected search hit is displayed near the center of the Document 
Window. Commands on the ProViewer Search menu allow you to look forward and 
backward in the current document for search hits and to move forward and backward in
the Search Results List to view other documents retrieved by the search.

To navigate via search hits within a document:

· To display the portion of the current document that contains the next search hit,
click on the Next Hit icon on the Toolbar or select the Next Hit   command   from 
the Search menu. This command and its icon are inactive when there are no 
additional hits in the current document..

· To display the portion of the current document that contains the previous search
hit, click on the Previous Hit icon on the Toolbar or choose the Previous Hit     
command from the Search menu. This command and its icon are inactive when 
there are no previous hits in the current document.

To navigate via search hits across documents:

· To open the next document in the Search Results List, click on the Next 
Document icon on the Toolbar or choose the Next Document   command   from 
the Search menu. Next Document automatically closes the current document 
before opening the next document in the list. 

This command and its icon are inactive when the current document is the last 
document in the Search Results List.

· To open the previous document in the Search Results List, click on the Previous 
Document icon on the Toolbar or choose the Previous Document   command   
from the Search menu. Previous Document automatically closes the current 
document before opening the Previous document in the list. 

This command and its icon are inactive when the current document is the last 
document in the Search Results List.

To redisplay the Search Results window:

· Click on the Search Results icon on the Toolbar
· Choose the Results   command   from the Search menu to redisplay the Search 

Results window. 

This is useful when you have viewed several documents and wish to review the 
overall results of the search, or refine the search in some way.

To go back to the previous location:

· Click on the Go Back icon on the Toolbar 



· Choose the Go Back command on the Go to menu

See also
Improving Your Search Results 
Search Facility Description 
Starting a Search 



Improving Your Search Results

As you work with the results of your search, you may discover that your Search Results 
List is not quite on target for your needs. The Common Ground Search functionality 
provides a number of options for rerunning and refining your search. 

· Change the document collections. 

Instead of searching in all collections, you may wish to select particular 
collections.

· Find particular documents. 

Besides the option of selecting collections, you also have the opportunity to 
specify particular information about documents of interest. The expanded 
Search Window allows you to specify document information and dates.

· Limit the documents. 

The expanded Search Window allows you to specify the maximum number of 
documents returned or to eliminate documents with low scores from your 
Search Results List. 

· Change the Query. 

The Query language contains many constructs that can help you. (See 
Specifying a Query.)

· Constrain the search. 

You can add special information about how to interpret the query phrase. (See 
Expanded Search Window.)

· Refine the search. 

In cases where you have performed a successful search but obtained a Search 
Results List that is too long to be useful, you can reduce the length of the list by 
refining the search.    (See Expanded Search Window.)

See also
Navigating the Results of a Search 
Search Facility Description 
Starting a Search 
 



Search Facility Menu Commands and Tools

Search Menu
Query
Results
Next Document
Previous Document
Next Hit
Previous Hit

Search Tools
ProViewer with Search Facility Toolbar
Query Tool
Search Results Tool
Next Document Tool
Previous Document Tool
Next Hit Tool
Previous Hit Tool 



Query Command (Search Menu)

Searches in defined document collections for documents with specific content; allows 
you    to create and edit document collections.    This is the principal access to the 
Common Ground Search facility. You can also access the Common Ground Search 
facility from an icon in the Common Ground Program Group.

See also
Query Tool



Results Command (Search Menu)

Displays the Search Results List generated by the Query command. This command is 
inactive when no search has been performed.

See also
Results Tool



Next Document Command (Search Menu)

Opens the next document in the Search Results List, replacing the current document in 
the Document Pane. This command is inactive when there is no next document or 
when no search has been performed.

See also
Next Document Tool
Previous Document command



Previous Document Command (Search Menu)

Opens the previous document in the Search Results List, replacing the current 
document in the Document Pane. This command is inactive when there is no previous 
document or when no search has been performed.

See also
Next Document command
Previous Document Tool



Next Hit Command (Search Menu)

Displays the appropriate portion of the current document that contains the next 
instance of the search term found by a Query command. This command is inactive 
when:

· No search has been performed
· No terms have been found
· There are no more hits in the current document

See also
Next Hit Tool
Previous Hit command



Previous Hit Command (Search Menu)

Displays the appropriate portion of the current document containing the previous 
instance of the search term found by a Query command. This command is inactive 

· No search has been performed
· No terms have been found
· There are no earlier hits in the current document

See also
Next Hit command
Previous Hit Tool



ProViewer Toolbar with the Search Facility

The search tools in Toolbar are inactive unless you have a version of ProViewer that 
contains the Search Facility. The search tools are located to the right of the Go Back 
tool (see the illustration above).    Selecting a search icon on the Toolbar produces the 
same result as choosing the equivalent command from the menu. 

Hiding the Toolbar
Select the Toolbar command from the Window menu. 

Redisplaying the Toolbar
Select the Toolbar command from the Window menu.



Using the Query Tool

Use the Query tool to access the Search Facility.

To use the Query tool:
Click on the button to display the Common Ground Search window.

See also
Query command
Specifying a Query



Using the Results Tool

Use the Results tool to display the results of the last query. This tool is inactive when no
search has been performed.

To use the Results tool:
Click on the icon to display the Common Ground Search Results window.

See also
Results command



Using the Next Hit Tool

Use the Next Hit tool to display the next instance of the search term found by a Query     
command. This tool is inactive when you have not performed a search or if there are no
additional instances of the search term.

To use the Next Hit tool:
Click on the Next Hit icon to display the next matching term.

See also
Next Hit command
Previous Hit Tool



Using the Previous Hit Tool

Use the Previous Hit tool to redisplay the previous instance of the search term found by
a Query   command  . This tool is inactive when you have not performed a search or if 
there are no previous instances of the search term.

To use the Previous Hit tool:
Click on the Previous Hit icon to go back to the previous matching item

See also
Next Hit Tool
Previous Hit command



Using the Next Document Tool

Use this tool to open the next document in the Search Results List. This tool is inactive 
if you have not performed a search or if the current document it the last document on 
the Search Results List.

To use the Next Document tool:
Click on the Next Document icon to replace the current document with the next 
document in the Search Results List.

See also
Next Document Tool
Previous Document command



Using the Previous Document Tool

Use this tool to open the previous document in the Search Results List. This tool is 
inactive if you have not performed a search or if the current document it the first 
document on the Search Results List.

To use the Previous Document tool:
Click on the Previous Document icon to replace the current document with the 
previous document in the Search Results List.

See also
Previous Document Tool
Next Document command

 



Save Tool
Saves the document. Works the same as the Save command on the File menu.



Print Tool
Prints the document. Works the same as the Print command on the File menu.



Open Tool
Displays the Open dialog box so you can specify which document to open. Works 
the same as the Open command on the File menu,



Pointer Tool

Restores cursor to normal arrow shape. Use it to select commands or select items to 
display for editing.



Table of Contents Tool
Changes the cursor to look like the icon. Use it to create Table of Contents entries.



Find Tool
Displays the Find dialog box so you can specify text for which to search. Works 
the same as the Find command on the Search menu.



Go Back Tool

Returns to the last navigation that you performed.



Grabber Tool

Changes the cursor to look like the Grabber icon. Use it to move the document or page.



I-Beam Tool
Changes the cursor to an I-Beam. Use this tool to select text in the document.



Hyperlink Tool
Changes the cursor to look like the    Hyperlink icon with an I-Beam or Marquee. 
Use this tool to select the source of a link.



Highlighter Tool
Changes the cursor to look like the Highlighter icon with an I-Beam or Marquee. 
Use this tool to create a highlighted area in the document.



Note Tool
Changes the cursor to look like the Notes icon. Use this tool to place a note on the
document.



Marquee Tool
Changes the cursor to a crosshair shape. Use this tool to select or define a 
rectangular area of the document page.



Zoom In Tool
Changes the cursor to a magnifying glass with a plus (+) in the center, Use this 
tool to magnify the current page.



Zoom Out Tool
Changes the cursor to a magnifying glass with a minus (-) in the center, Use this 
tool to decrease the magnification of the current page,



Bookmark Tool
Changes the cursor to look like the Bookmark icon. Use this tool to mark a specific
location in the document to which you want to navigate.



Query Tool
Opens the Common Ground Search window.



Search Results Tool
Opens the Search Results List dialog box.



Next Document Tool
Opens the next document in the Search Results List, replacing the current 
document in the Document Pane. 



Previous Document Tool
Opens the previous document in the Search Results List, replacing the current 
document in the Document Pane. 



Next Hit Tool
Displays the portion of the document that contains the next instance of the 
search term in the current document.



Previous Hit Tool
Displays the portion of the document that contains the previous instance of the 
search term in the current document.
 



Add Collection Dialog Box

To access the Add Collection dialog box:

1. In the Search window, click on the Collections button.
2. Click on the Add button

Dialog Box Options
Directories

Specify the directory that contains the collections you want to use.

Drives

Specify the drive that contains the directories you want to use.

Collections

Select the collection that you want to add to your list.

Add Button

Click on this button to add the selected collection to your list. This button is 
inactive if you have not selected an collection.



Create Collection Dialog Box

To access the Create Collection dialog box:

1. In the Search window, click on the Collections button.
2. Click on the Create button

Dialog Box Options
Description

Enter a description of the collection. A description is any combination of 
characters.

Location Button

Display the Select Location dialog box in which you can select the directory 
where this collection will be stored. The default location name appears to the 
right of the button. 



Document Collections Dialog Box

To access the Create Collection dialog box:

In the Search window, click on the Collections button.

Dialog Box Options
(Check Column)

Double-click to check or uncheck collections. A check indicates that the 
document will be included in any search that is limited to selected collections.

You can also toggle the check by highlighting a collection and pressing the 
space bar once.

Collections

Displays the collections on your list. Click on a collection description to identify 
which collection you want to edit or update. 

Create Button

Click on this button to display the Create Collections dialog box in which you can
create new collections.

Add Button

Click on this button to display the Add Collection dialog box in which you can 
add existing collections to your list.

Edit Button

Click on this button to edit the selected collection. This button is inactive if you 
have not highlighted a collection in the list.

Remove Button

Click on this button to remove the selected collection. This button is inactive if 
you have not highlighted a collection in the list. Selecting this button displays 
the Remove Collections dialog box.



Edit Collection Dialog Box

To access the Edit Collection dialog box:

1. In the Search window, click on the Collections button to display the Document 
Collections dialog box.

2. Click on a collection name in the Collections list.
3. Click on the Edit button.
        Once the Document Collections dialog box appears, you can double-click on a 

collection name to access the Edit Collection dialog box.

Dialog Box Options
Description

Displays the name of the collection. You can change the name of the collection 
by typing your changes in the field.

File Name

Select the document file that you wish to edit, update, or remove.

List Files of Type

Specify the type of files on which you want to work.

Note: Although you can display all types of document in this list box, you can 
only add Common Ground documents to a collection.

Directories

Specify the directory that contains the documents you want to use.

Drives

Specify the drive that contains the directories you want to use.

Files in Collection

Displays the files contained in the current collection. This list changes as you 
add or remove documents from the collection. 

You must highlight one of the files in this list before you can update it or remove
it from the collection.

Add Button

Click on the Add button to add the selected file to the collection. This button is 
inactive if you have not highlighted a file.

Add All Button



Click on this button to add all documents in the current directory to the 
collection.

Remove Button

Click on this button to remove the selected document from the current 
collection.

Remove All Button

Click on this button to remove all documents from the collection.

Update Button

Click on this button to re- index the selected document.

Update All Button

Click on this button to re-index all documents in the collection.



Remove Collection Dialog Box

To access the Remove Collection dialog box:

1. In the Search window, click on the Collections button to display the Document 
Collections dialog box.

2. Click on a collection name in the Collections list.
3. Click on the Remove button.

Dialog Box Options
Delete the collection from Disk

Check this button to remove the collection and its description from your system.

Remove Button

Click on this button to remove the collection.



Select Location Dialog Box

To access the Remove Collection dialog box:

1. In the Search window, click on the Collections button to display the Document 
Collections dialog box.

2. Click on a collection name in the Collections list.
3. Click on the Create button to display the Create Collections dialog box.
4. Click on the Location button.

Dialog Box Options
Collection Location

Displays the location of the new collection. Change the location by specifying a 
drive and directory in the other fields.

Directories

Specify the directory in which you want the collection located.

Drives

Specify the drive in which the desired directory resides.
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